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Preface
Photo Retriever (including program, document fi le and manual) is protected by copyright laws and international 
copyright treaties, as well as other intellectual property laws and treaties. Photo Retriever is licensed, not sold. 
Please read the License Agreement in the box. End-user conditions are set forth in the License Agreement. You 
may not disassemble, reverse-engineer, decompile, resell, re-program or document any of Photo Retriever.
The source code of the Photo Retriever program is copyrighted by FINAL DATA INC.  All the 
document files of Photo Retriever are copyrighted by AlphaOmega Soft, Inc.  and FINAL DATA 
INC.  All other trademarks used herein are registered trademarks of their respective holders.
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1 .  U s e r  R e g i s t r a t i o n  a n d  S u p p o r t
1.1 .  User  Regist ra t ion 

User registration allows you to receive technical support, product updates and other benefi ts. 
The following is a list of services available after registration.
•   Technical support via email.

 •   Downloadable product updates (http://www.fi naldata2.com).
 •   Serial number tracking (we will maintain a record of your registered serial number in the situation  
  that it has been lost or misplaced).  
 •   Special promotional offers via email (opt-in only).  

1.2 .  How to  Register
•  Internet Registration
 To register online, visit our website (http://www.fi naldata2.com) and follow the registration links to 
 complete registration.  Please fi ll in all necessary fi elds including serial number and user information.
• Convenient User Information Update.
 When you change your address or phone number, please email the updated information to 
 support@fi naldata2.com

1.3 .  Technica l  Support  Opt ions
 You can contact Photo Retriever technical support at the following email.
 • Email Response Support : support@fi naldata2.com
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2 .  I n t r o d u c t i o n  t o  P h o t o  R e t r i e v e r
2.1. How Photo Retriever Works

Photo Retriever is designed to recover deleted image fi les such as JPEG, GIF, TIFF, PNG, RAW, PSD, PCX, WMF 
and BMP; video fi les such as AVI, MPEG, MOV; and audio fi les such as MP3, MID, and WAV. Photo Retriever 
does not guarantee recovery of all data.  Overwritten fi les or fi les that have been severely damaged can not be 
recovered by Photo Retriever.

Microsoft Windows provides a Recycle Bin ( ) function to protect you from accidental data deletion.  When a 
fi le is deleted in Windows, it is fi rst moved to the Recycle Bin and can be recovered if needed.  If, however, a fi le 
is deleted from the hard drive without being stored in the Recycle Bin ([Shift]-[Delete]), or if the user has emptied 
the Recycle Bin, it can not be recovered in Windows.

But when a fi le is deleted in Windows only the fi le directory information is removed, which means the fi le data still 
resides in data sectors on the hard drive.  So, the fi le can technically be recovered.

Photo Retriever uses these principles to recover data, even after the Recycle Bin has been emptied.  Photo 
Retriever is able to easily recover deleted fi les, fi les damaged by viruses or by accidental formatting. Even when 
a directory structure is partially damaged, Photo Retriever can recover the fi les as long as the data remains on the 
hard drive.

2.2.  Photo Retriever Features     
User-Friendly
It’s fast and easy! If you know how to use Windows Explorer, you’re well on your way to recovering lost fi les in a 
few easy steps.

Data recovery after virus infection
Traditional vaccine and fi rewall programs often do not provide security against new viruses.  Photo Retriever will 
completely restore lost data caused by many viruses and hackers attacking your system directory structure or fi le 
tables.

Photo Retriever is Windows XP compatible
Photo Retriever is compatible with Windows XP, as well as Windows95/98/Me/NT/2000.  With Photo Retriever, 
complicated DOS commands are never required - with a few clicks of a mouse, Photo Retriever can recover your 
data.
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Photo Retriever is reliable
Photo Retriever is recognized for its superior simplicity, safety, speed and rate of recovery.

Data Recovery after emptying the Recycle Bin
Photo Retriever can recover your fi les as long as the data has not been overwritten and the information still exists 
on your storage device.  Photo Retriever can even recover fi les that data recovery laboratories can not. 

Keeps your information private
If the data is so important that even a data recovery technician should not see it, you can recover the data yourself 
and keep your information private.

Data recovery from CD-ROM drives and removable drives
Photo Retriever is capable of recovering data stored on several types of storage devices including CD-ROM, 
DVD-ROM, fl ash memory, memory stick, and MO/ZIP/Jaz drives.
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3 .  I n s t a l l / U n i n s t a l l
3.1 .  Before  Insta l l ing  Photo Retr iever
1.  Photo Retriever installation requires the original CD and its serial number. Please keep them in a secure 

location.

2.   If you have an earlier version or a demo version of Photo Retriever installed on your system, uninstall it 
before installing Photo Retriever 2.0.

3.  Please keep in mind that if you install Photo Retriever on the same drive you need to recover data from, 
the installation process might overwrite your previously lost data.  Therefore, it is recommended that Photo 
Retriever be run for the fi rst time from the CD-ROM drive.  To run the program from the CD-ROM fi nd the 
Photo Retriever executable fi le.  This fi le is typically located in the following directory: D:\PhotoRetriever\
PhotoRetriever.exe (D: representing your CD-ROM drive).  To launch the program, go to the ‘Start’ button 
on the Windows task bar and select ‘Run’.  Then click ‘Browse’ and  fi nd the executable fi le on the Photo 
Retriever CD-ROM.  After your data has been recovered you can safely install Photo Retriever for any future 
instances of data loss.

4.  Data can not be recovered from a physically damaged hard drive. A hard drive can become unrecoverably 
damaged if it is dropped, becomes wet, or is damaged by fi re.

5.  When previously deleted data in need of recovery is overwritten by other data, it generally can not be 
recovered.

6.  When data restored by Photo Retriever has initially been fragmented, it may not be usable by other programs.

7.  Photo Retriever is specifi cally designed for the purpose of recovering image fi les such as JPEG, GIF, TIFF, 
PNG, RAW, PSD, WMF, PCX and BMP; video fi les such as AVI, MPEG, MOV; and audio fi les such as MP3, 
MID, and WAV.  It can not recover operating system fi les, application programs, or other types of damaged 
data. 

8.  A separate drive is required for saving the recovered fi les.  To protect deleted data from becoming 
overwritten, recovered data must be saved on a different drive.

9.  Due to various fi le deletion methods adopted by different camera manufacturers, some images may not be 
recovered once deleted.
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10.  Users other than the administrator can not run the Photo Retriever under Windows NT/2000/XP.

11.  Because of the limited directory entry space in a cluster, not more than 10 fi les from any subfolders on a 
fl oppy disk can be retrieved at one time (unless a defragmenter program is employed) despite the number of 
fi les on a fl oppy diskette subfolder. With the exception of a fl oppy disk, most media are limited regarding 
their detectable number of fi les within the FAT fi le system, when fi les exceed the number of directory entry 
storable in one cluster or in one folder, the number of fi les retrieved at one time may be limited.

12.  Photo Retriever can not be used on drives with disk compression software.

13.  If a folder with a minimal amount of data was formatted, not all of the data will be recoverable.

14.  When Windows is interrupted or restarted after a fi le has been deleted in a NTFS fi le system, part of the 
deleted fi le may not be recoverable.

15.  Photo Retriever can not recover a fi le on a hard drive that has been deleted or repartitioned by FDISK or 
Windows [Disk Management].  Files on a disk or media not recognized by Windows can not be recovered in 
most cases.

16.  Since no drive letter is associated with a Windows 2000/XP dynamic volume, the drive can not be scanned.

17.  Image fi les encrypted with the NTFS fi le system can not be opened, even after recovery.

18.  A fi le deleted from a FAT32 fi le system under Windows 2000/XP can only be recovered when a cluster scan 
is performed.

19.  A user without local administrator rights could be denied program installation on Windows 2000/XP systems. 
In such cases, the following message will appear:

 “Setup has detected uninstall shields are in use. Please close the uninstall shield and start setup again.” 

“Error432” 

 To correct this issue, login as a local administrator and try installing the application again.  
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20.  Portions of images larger than 1800 pixels in length or width may not be visible as a thumbnail, during 
preview, or printing under the Windows 95/98 environment.

21.  Data recovery can be performed easier on hard drives that are regularly maintained by the Windows Disk 
Defragmenter.  Make sure to always backup important fi les before using the Windows’ defragment tool. 
Avoid defragmenting drives if they have deleted data that needs to be recovered. Defragmenting a drive after 
data has been deleted will render the data completely unrecoverable. 

22.  Before starting the recovery process, make sure that Windows is operational and an extra drive is available 
to save the recovered data. If Windows does not boot-up, and the deleted fi les reside on the same drive as 
Windows, do the following:

Attach the affected disk as a slave drive to another system with a functioning Windows environment 
(and preferably the same Windows version), install and run Photo Retriever from the functioning system. 

23.  The Photo Retriever license agreement is issued for one computer or workstation.  Additional licenses have to 
be licensed if the program is to be installed on multiple computers.

24.  The program may appear to momentarily stop when you use the [Status] bar and click the [Detail] button to 
view detailed fi le information. This process will take a few moments, and the program will shortly resume 
interactive operations. 

25.  PSD, WMF, GIF and RAW fi le types can not be printed in Photo Retriever. 

26.  WMF, GIF and RAW fi le types can not be previewed in Photo Retriever. 

27.  The default size will be applied to the fi le which is found by cluster scan. 



Photo Retriever Next Generation Media Recovery

            USER MANUAL          F INALDATA Ser ies  Photo Retr iever  2 .0    11  

3.2 .  System Environments
Please check the minimum PC system requirements before using Photo Retriever:
· O/S: Windows 95/98/Me/NT4.0(workstation, with SP4 or higher)/2000(Professional)/XP
· Minimum 64MB of RAM (128MB or more recommended) 
· At least 10MB of free disk space (20MB or more recommended)
· 2x CD-ROM Drive or faster 
· 256-color VGA or higher resolution  

3.3. Photo Retriever Installation
Installing Photo Retriever
You can install Photo Retriever 2.0 for Windows as follows:
· Start Windows.
· Insert the Photo Retriever 2.0 CD into the CD-ROM drive. The setup program will launch automatically.
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If the setup program does not launch automatically, please take the following steps:
· Double-click the [My Computer] icon on the desktop.
· Double-click [CD-ROM Drive].
· Open the [Setup] folder.
· Run “Setup.exe”.

Note:  When Installation starts, a warning stating that you may overwrite recoverable data by software installation 
will appear.  If you do not wish to install Photo Retriever, Click “No” to install Photo Retriever.  You may still run 
Photo Retriever from the CD-ROM (Please refer to Chapter 3.1 –Before Installing Photo Retriever).  

Click [Next] to continue with Photo Retriever 2.0 installation.
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Click [Yes] after reading the above Software License Agreement.

Enter your name, the company name, and the product serial number. Click [Next].
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· The above dialog box allows you to choose the installation folder for Photo Retriever. The default folder 
is “Program Files\FinalData\Photo Retriever 2.0”. To install to a different folder, click 
[Browse] and select another folder.

· Installing Photo Retriever to the same drive where fi les or folders are in need of recovery may potentially 
overwrite those fi les and folders. Please make sure that the drive where Photo Retriever is to be installed has no 
data in need of recovery. Click [Yes] to continue to install.
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Uninstalling Photo Retriever 

Click the [Start] button and choose [Programs] - [Photo Retriever] - [Uninstall Photo Retriever]. Photo Retriever 
will be removed automatically.

If this item is not available, you can remove Photo Retriever as follows:
· Start Windows.
· Select [Start] - [Settings] - [Control Panel].
· Open the [Control Panel] and double-click [Add/Remove Programs].
· Select [Photo Retriever 2.0] and click the [Add/Remove] button.
· Photo Retriever fi les and folders will be removed.
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4 .  G e n e r a l  D a t a  R e c o v e r y  P r o c e d u r e  o f  
    P h o t o  R e t r i e v e r  2 . 0

4.1. Launching Photo Retriever
Click [Start] and choose [Programs] – [Photo Retriever] – [Photo Retriever 2.0].
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Logica l  Dr ive  Search
From the [Select Drive] dialog box, click the drive containing the data you wish to recover. Click [OK].
If detected, other types of memory cards such as SmartMedia or CompactFlash will also be listed in the [Select 
Drive] dialog box.

Network drives will not be listed.
Drives not recognized by Photo Retriever will not be displayed.

The main screen will be displayed as follows:  
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Select the fi le type(s) to recover and click OK.

4.2 .  D i rectory  Scan 
After selecting the fi le type(s) to recover, a [Directory Scan] will be started.  

It is necessary for the [Directory Scan] to run thoroughly. If you click [Cancel] before the completion, results for the 
scanned parts of the drive will only be displayed.
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4.3 .  C luster  Scan
If the [Apply Detail Search Algorithms] was checked a more detailed search will begin automatically after the 
Directory Scan has completed.

Note:  When images are deleted from a digital camera, you will need to choose the [Apply Detail Search Algorithms] 
option, since without a [Cluster Scan], image data will not be found.  After the [Directory Scan] the [Cluster Scan] will 
automatically start. During a [Cluster Scan], other fi les may be found that did not show up with the initial [Directory 
Scan].  Since this process may take a considerably longer time (depending on the size of the hard drive), you have 
the option to stop it by clicking the [Cancel] button. 



User Manual

20 USER MANUAL FINALDATA Ser ies  Photo Retr iever  2 .0

4 .4 .  Scanning Resul t
Scanned media fi les are displayed as thumbnails. A maximum of 128 thumbnails can be displayed at the same 
time.  However, part of a thumbnail may appear blank at this point.

A clear image thumbnail in Photo Retriever indicates a higher possibility of recovery, and easy image access for 
the future. If the default icon of Photo Retriever is displayed in the thumbnail area of a picture, it can suggest the 
possibility of fi le damage which may also prevent it from being opened. Limited computer resources may cause 
thumbnails to show up as blanks. In this case, the status and extent of damage to the image will not be verifi able 
unless it is recovered.
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Choosing [Details] from the [View] menu:

Detailed information about the fi les will be displayed. The following detail information will be displayed by 
setting the [Detail] information: Short name, status, cluster, size, date of creation, date of modifi cation, date of 
application, sort, folder, etc. To set these items, please refer to “4.9. Preferences”. 
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4 .5 .  Prev iew an image f i le  in  need of  recovery
To preview an image fi le, use the “Preview” function of Photo Retriever.  Select a fi le from the list and click the 
(  ) button on the toolbar, or choose [Preview] from the pop-up menu that appears when you right-click on 
an image fi le.
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Print the selected image by:

Selecting [Print] from the [File] menu, or clicking the  (          ) button on the toolbar.

4.6 .  Choose & Pr int  an  image f i le  in  need of  recovery
To print an image fi le, you will need to fi rst select it from the list by clicking on it. 
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4 .7 .  Recovery
Select the fi le(s) from the list.

Choose [Recover] from the [File] menu, or click on the (           ) button on the toolbar. You can also Choose 

[Recover] from the pop-up menu that appears when you right click on a fi le.
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Select the drive and folder to save the recovered data to, and click the [Save] button.

To create a new folder, click the  (           ) button.

To prevent overwriting, the program will not let you save recovered fi les on the same drive the previously deleted 
data resided. 
Make sure secondary drives are available and have enough capacity to store recovered data. Other media that can 
be used for this purpose are:

→ Floppy disk drive
→ Removable disks such as MO or ZIP
→ Shared network drives
→ Another logical or physical disk

Note:  CD-R drives can not be used for recovery.
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4 .8 .  Conf i rmat ion of  recovered data
Windows Explorer can be used to verify if a fi le has been recovered as intended, by the previously outlined 
section. To fully confi rm the recovery, open the fi le in an application that supports the type of fi le being recovered.

However, the following scenarios could occur:

→The fi le will not open.
→ The fi le opens, but is partially damage.
→ The application stops suddenly while opening the fi le.

The preceding scenarios can be caused by overwritten data or data fragmentation.
 
As an alternative method of recovery in the case of the FAT16 or FAT32 fi le system, select [No FAT] for the FAT 
type during the [4.7 Recovery Section] process to recover the data. Recovery will not be possible if this does not 
work.

Note:  The FAT type option is not available if the fi le system is NTFS.
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4.9 .  Preferences
To modify the preferences, choose [Preferences] from the [File] menu, or click on the (            ) button of the 
toolbar.  By choosing the [Preferences] option, you can turn on or off additional columns of detailed information 
that will be displayed on the main screen of Photo Retriever.  The following items are among the preferences that 
can be displayed: 
Short Name, Status, Cluster, Size, Date of Creation, Date of Modifi cation, Date of Access, Type and Directory. 

Note:  Short name item is not available for the NTFS fi le system.
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5 .  E r r o r  M e s s a g e s  &  T r o u b l e s h o o t i n g
5.1. Drive wil l  not open
The specifi ed drive may not be accessible. Due to problems or damage to the Master Boot Record (MBR), the 
drive can not be opened. Recovery in this case is impossible.

5.2.  Can not read xx sector
This message appears when data is not readable because a bad sector has been encountered in the xx area. Click 
[Ignore] or [Ignore all] to continue the process. If the No. 0 sector on a removable storage media, such as a fl oppy 
disk or a MO drive is bad, you will not be able to access its data.

5.3.  This f i le type is not compatible
This message points to a fi le system other than a FAT12, FAT16, FAT32, NTFS (or the fi le system has been 
damaged) or a UDF formatted disk. Photo Recovery can not proceed in this case.

5.4.  Can not move directory
The directory can not be moved because there is no entry in the directory that needs to be moved. Either the new  
directory location has been overwritten or its sectors are damaged. The FAT32 deleted directory entry may be 
inaccessible.

5.5.  Can not recover in the working drive -  Please select another drive

Photo Retriever prevents users from saving data to the same drive carrying out the recovery tasks, since saving data 
to the recovery drive might overwrite other data that is in need of recovery. If an error message is displayed when 
you attempt to save fi les to the recovery drive, you should save your data to another drive. If you have no other drive 
available in your computer system, you may recover the data as follows:
Save small fi les to a fl oppy disk.
Save fi les in large-capacity storage media such as ZIP or MO drive.

5.6.  Photo Recovery is on the way
Thumbnails are being generated - Please wait.

5.7.  Can not print due to lack of memory capacity
This message indicates that there is not suffi cient memory for the printing process to continue.  Stop printing 
temporarily and push the print icon again.
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5.8.  Some fi les are not l isted in the folder among other f i les
This can happen either when a directory entry is fragmented, or has been overwritten. In this case, it is impossible 
to recover data to its normal condition.

5.9.  A f i le is l isted as a “Continuous File”,  but i t  is not recoverable
A fragmented fi le can in some cases be marked as a “Continuous File” (especially after formatting, since FAT is 
rewritten). In some cases, it is not possible to recover data since some data is overwritten.

5.10. No f i les are displayed after scanning a formatted hard disk
The above condition can be the result of several factors:

→ The new disk format is different from the previous fi le system. (FAT32 to NTFS, or vice versa)
→ The disk has been formatted several times.
→ A format has been made by adjusting the size of the partition.
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6 .  G l o s s a r y
6.1. Fi le System
A fi le system is a structure for managing fi les on magnetic storage media (fl oppy disk, hard disk). It organizes fi les 
and folders by actually corresponding them to the physical disk. A fi le system is managed with information such 
as directory entries and FAT (fi le allocation table).

6.2.  FAT File System
The FAT fi le system is categorized into FAT12, FAT16, and FAT32.  FAT12 is the fi le system used in fl oppy 
disks, MS-DOS, Windows 3.1 and Windows 95.  Starting with Windows 95 OSR2, both FAT16 and FAT32 are 
supported.
FAT is an index table indicating data location by cluster.  As a safety measure, a duplicate is also kept.
In the FAT fi le system, a fi le is assigned to a cluster.  When there is a new fi le, its entry is fi rst created and the start 
cluster number is assigned.  Next, the fi le’s fi nal cluster (EOF) or the next cluster is recorded in the corresponding 
entry.

6.3.  NTFS File System
Windows NT/2000/XP supports NTFS.  Compared to FAT, NTFS is an advanced fi le system in terms of security 
and reliability.

6.4.  FAT (Fi le Allocation Table)
A fi le is confi gured in a cluster unit. However, clusters of a single fi le are not always stored in adjacent physical 
locations on a disk.  Therefore, it is necessary to manage how clusters are linked to constitute a single fi le. FAT 
functions perform this task.  Each entry in FAT has a 1:1 correspondence with a cluster; so when using such FAT 
information, a fi le’s location on the hard disk can be identifi ed.

6.5.  MFT (Master Fi le Table)
All data is managed in a fi le structure on volumes formatted for the NTFS system. The MFT (Master File Table) is 
a fi le system which has an information table for such fi les. MFT stores fi le contents for small fi les which have less 
than 1 MB. However for fi les larger than 1MB, it only keeps a record identifying which cluster the contents of a 
fi le resides.

6.6.  Folder
A directory is called “a Folder” in Windows. This manual expresses folders for most directories except when 
referring to a “directory entry”, “directory scan”, “root directory” and some other special cases.
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6.7.  Directory Entry
Contains a long fi le name, extension, fi le size, MS-DOS fi le name, modifi ed data/time and the fi le’s start cluster. 
For fi les and directories saved in the root directory, the directory entries are saved in the root directory area. 
However, directory entry of fi les saved in lower directories are stored in the data area.

6.8.  Sector
Magnetic storage media such as hard disks or fl oppy disks are divided into regions for effi cient data identifi cation. 
The smallest space of a unit’s  region is referred to as a “sector”.  A disk track is partitioned into several sectors 
for management.

6.9.  Bad Sector
A sector that can not be read properly, due to damage or magnetic error on its surface. In many cases we may 
neither be able to read the contents of the bad sector nor the rest of the disk.

6.10. Cluster
One or more sectors form a cluster for recording data.  For example, saving a document consisting of a single 
character as a fi le requires one cluster.

6.11. Root Directory
Refers to the highest directory in the drive’s directory structure.  Sub-directories are created under the root 
directory. 

6.12. FAT 1
There are two areas of FAT information on a hard disk. They are: FAT1 and FAT2.  FAT2 works as a backup for 
FAT1 in the case of an unexpected situation. This FAT contains various fi le information like location, size, name, 
etc. In general, when a fi le is deleted only the FAT information about the location of a fi le will be initialized while 
the actual data will remain unchanged. When “FAT1” is chosen, data recovery will be enacted based on this FAT 
information.

6.13. No FAT
Is an option to recover data without referring to any FAT information on a hard disk. For example, when “No 
FAT” has been chosen for data recovery, fragmented data will be considered as continuous data for fi le recovery.

6.14. Thumbnail
A thumbnail is a reduced sample of an image fi le and a small image preview displayed so that the fi le’s contents 
can be verifi ed before opening.


